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IN THIS ISSUE  
  
             President’s Message...  

 
               Donna Curtis is currently the chief of the accounting liaison office in the     
             72d Comptroller Squadron at Tinker AFB.  She is also our current Chapter  
  president and agreed to be interviewed about her involvement in the ASMC Sequoyah 

     Chapter.  She shares her experiences and insight here with Chapter members… 
 

1 President’s Message 

1 Results of CGWI 

      Backpack Drive 

2 Ticket Monitors 

2 Treasurer’s Report  How long have you been a member of ASMC?   
Since 2003. 

 
 Why did you decide to join ASMC?  

I came into the organization as an accountant—
with face and name unknown.  I wanted to 
advance in my career so I sought to be mentored 
and to network within my peer group. 

 
 What do you expect by being an ASMC 

member?  
I expect the opportunity to network, to learn 
more about the FM world by picking up 
information from others, and to make a 
difference.  The Chapter is not an entity of its 
own—the people make it what it is.  I expect to 
better myself from my association, as well, as 
making it better for others. 

 
 What inspired you to become a Chapter officer?  

First, I was Vice-President before becoming 
President.  It was an opportunity to contribute 
and become more involved in the Chapter.  As 
only a member, my voice didn’t carry much 
weight.  I am honored and was surprised to have 
been nominated for this opportunity by my peers. 

 As President of the Sequoyah Chapter, 
how do you hope to make a significant 
contribution?  
Since I’ve been President, the Chapter is 
planning to hold its first fundraiser and 
first holiday party ever.  I want to make it 
fun and enjoy being a part of it—it’s more 
than just luncheons.  I’d like to raise more 
funds to increase scholarships.  I would 
also like to institute a member mentoring 
program—not just for journeyman-level 
members, but for lower grade members to 
promote more career development. 

 
 Is there anything else you’d like to tell 

Sequoyah Chapter members?  
When I’m not the Chapter President, I am 
a wife, a mother, and a grandmother of 
three (with two more on the way).  I have 
been certified as a defense financial 
manager and have earned a master 
degree in Human Relations.  I am 
honored to be a part of this Chapter and 
to serve as its President for 2009-10. 

2 Membership Report 

2 Recent Luncheons 

3 Upcoming Luncheons 

3 Mini-PDI Kick-Off 

3 Craft Show Results 

4 Calendar of Events 

5 Article, “Continuing 

      Resolutions” 

6 Crossword Puzzle 

7 National ASMC News 

7 First Christmas Party 

8 Article, “Seven Ways 

      To Organize 

      Your Email” 

  

  

 

    

Results of CGWI Back-to-School Pack Drive 
 

                The donations of 21 backpacks full of supplies and $455 in 

             cash by members of the Sequoyah Chapter were presented to 
Loretta Jackson, with the CG Wells Institute, by Donna Curtis, our Chapter 

President.  Because of this, their organization exceeded  

their goal of 200 backpacks.  Ms Jackson said that nearby 
schools are calling her for assistance now—ones that  

never have before because they previously didn't know  
she provided this kind of assistance.   

A big party was held at the Joe B. Barnes Regional 
Park, in Midwest City, where the backpacks were given  

out to the kids, along with hot dogs and other treats. 

“Thanks” to everyone who contributed to this effort 
and making a positive difference in these children’s futures. 
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TICKET MONITORS 
 Our biggest event of the year is right around 

the corner!  If you are interested in serving 
on a committee for the next Chapter Mini-

PDI, please contact Carolyn Hamilton at 
884-5726 or carolyn.hamilton@tinker.af.mil. 

72CPTF Bldg 1 Susan Staudt 888844--88552200  

AWACS Bldg 280 Loretta McCoy 884-1598 

72CES Bldg 400 Paul Dean 884-3022 

AFAA Bldg 510 Anthony Buck 884-8172    

507ABW Bldg 1043 Lee Ann Morrison 884-7207 TREASURER REPORT 

76MXW Bldg 3001 Jennifer Goodridge 336-2132 Month Checking Savings 

327ASW Bldg 3001 Judy Crespo 339-2041 Aug 09 $10,524.80 $750.34 

448SCMW Bldg 3001 Donna Conover 336-2514 Sep 09 $11,094.76 $752.36 

OC-ALC Bldg 3001 Patricia Lindley 339-7370 Oct 09 $10,881.18 $752.36 

OC-ALC BBllddgg  33000011  Libby Curry 339-5226 MEMBERSHIP REPORT 

CLS BBllddgg  33000011  Dean Coleman 336-2928 Month General Corporate 

38EIG Bldg 4029 Darlene Tharp 339-4069 Aug 09 163 2 

wwwwww..aassmmccsseeqquuooyyaahh..oorrgg 
 Sep 09 163 2 

 Oct 09 163 2 

    

Chapter Luncheons 
  
RReecceenntt  LLuunncchheeoonnss……  

Mr Dan Gaston, Deputy Director of Contracting, in 
the Oklahoma City Air Logistics Center, at Tinker Air 
Force Base was our speaker at the Chapter luncheon  

  

 
RONALD MCDONALD 

HOUSE CHARITIES 

 
held on Wednesday, 19 Aug 09, 
in the ballroom at the Tinker 
Club.   Mr Gaston provided 
attendees with PK’s perspective 
on fiscal year closeout. 

Mr Gaston described the 
numerous responsibilities of the 
contracting organization, at 
every level, as well as, their 
several closeout processes.   

  

                      Two representatives from the 
Ronald McDonald House Charities came to our 
October luncheon to provide Chapter members with 
an overview on how RMHC helps families as we 
continue our collections throughout the year.  

Mr Gaston explained that some of their challenges 
are sole source contractors, decreased manpower, 
etc.  He stressed that fiscal year closeout is all year  

                                      around—not just at  
                                      yearend.   Success is  

 On Wednesday, 21 Oct 09, Mr Phil 

Davidson, senior instructor and Subject Matter 
Expert with Management Concepts, Inc., 
Financial Management Programs, provided a 
refresher briefing on the Anti-Deficiency Act  

                                           not reliant on databases or  for attendees, held in the Building 3001 
                                           metrics, but on relationships. 
   

 Oklahoma Room. 
Mr Davidson briefed 

attendees on the 
history, statutes, and 
components of the ADA, 
then discussed real case 
scenarios, reminding 
members of ADA rules. 
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Chapter Luncheons  (Continued) 
  
UUppccoommiinngg  LLuunncchheeoonnss……   

 

On Tuesday, 17 Nov 09, Mr John 
Gioeli, Manager of Government 
Programs, for Becker Professional 
Education, will be speaking at our 
Chapter luncheon.  Mr Gioeli has 
over 20 years experience working 
with Federal Government in the area 
of training and development and 
information resources.  He is a 
member of the Association of  

 On Thursday, 17 Dec 09, we will welcome         
Ms Jimmie Nolen, co-owner with husband, Jim, of 
Nolen’s Accounting & Tax Service, Inc., located in    
Del City, Oklahoma, since 1978.  Ms Nolen is a 
member of the Oklahoma Chapter of the National 
Society of Accountants, Del City Chamber of 
Commerce, Education Coalition Task Force, Mid-Del  

  

School Board, and Midwest 
City-Del City Public Schools 
Foundation.  Ms Nolen will be 
presenting the topic of ethics 
based upon Cynthia Cooper’s 
book, Extraordinary Circum-

stances.  The luncheon will be 

held in the Building 3001 
Oklahoma Room, at 1130 
hours. 

Government Accountants (AGA), as well, as ASMC.   
Mr Gioeli will be providing members with 

information of the requirements necessary to obtain 
certification as a public accountant (CPA) in the state of 
Oklahoma.  The luncheon will be held in the ballroom at 
the Tinker Club, from 1130 to 1230 hours.  

 

  
 

SEQUOYAH CHAPTER  
13TH ANNUAL MINI-PDI 

Kick-Off Meeting 
18 Nov 09 

  
Our biggest event of the year is 

right around the corner! 
Our Mini-PDI Kick-Off 

Meeting is will be Wednesday, 
18 Nov 09, from 1300 to 1400 in 
the OC-ALC/FM Conference 
Room.  If you plan to attend, 

please notify Carolyn 
Hamilton at 734-5726 or 
carolyn.hamilton@tinker.af.mil. 

 

  

CHAPTER CRAFT SHOW FUNDRAISER 
 
Our Chapter booth at the 

Arts & Crafts Show on  

30 Oct 09, in Bldg 3001, was 

a success!  We sold 

Christmas angel ornaments 

and a variety of chocolate 

bars.  We also held a silent 

auction with gift baskets 

and floral arrangements.  

Our earnings were $402.90.  

“Thanks” to all of you who 

came by to support the 

Ronald McDonald House 

Charities.  We do have 

some ornaments and candy left for sell.  Please contact Tammy Brandt, 

336-2326, or Donna Curtis, 339-7862, if you’d like to purchase some in 

support of this worthy cause. 
 

CChhaapptteerr  CCeerrttiiffiieedd  DDeeffeennssee  FFiinnaanncciiaall  MMaannaaggeerrss 

WWiillll  AAnnddeerrssoonn  

DDaavviidd  BBeerrggmmaann  

GGaarryy  BBoouurriissaaww  

JJaanneett  BBuucckknneellll  

TTaannyyaa  CChhiillddrreessss  

DDaarriiaa  CCrraannee    

JJuuddyy  CCrreessppoo  

DDoonnnnaa  CCuurrttiiss  

KKaatthhlleeeenn  DDaayy  

JJeeffffrreeyy  JJiilleekk  

SStteevveenn  JJoohhnnssoonn  

PPaauull  DDeeaann    

DDiiaannee  FFoorrtteellkkaa  

AAnnnn  FFrraannkklliinn  

SShheerrii  FFrroossiigg  

LLeeoottttaa  HHaallttmmaann  

CCaarroollyynn  HHaammiillttoonn  

NNaannccyy  HHaasskkeellll 

SShheelllleeyy  JJoonneess  

JJeeffffrreeyy  LLeeiidd  

MMaaggnnoolliiaa  LLiippsskkyy  

JJoohhnn  MMccKKeeee  

  CChhrriiss  PPaarrrryy  

DDeebbrraa  PPoollaanndd    

SSaannddrraa  PPuurryyeeaarr  

TTeemmppiiee  RRoobbeerrttssoonn  

CChheerryyll  RRoobbiittaaiillllee  

AAnnggeellaa  RRuutteerr  

JJoohhnn  SSccootttt  

CChhaarriissssee  SSllaarrvvee    

  RRoobbeerrtt  SSllaarrvvee  

VVaalleerriiee  TTiillkkeennss  

LLoorrii  TTuucckkeerr  

LLaaTTrriiccee  VVaauugghhnn  

  

CCDDFFMM--AA 
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    SSEEQQUUOOYYAAHH  CCHHAAPPTTEERR  CCAALLEENNDDAARR  OOFF  EEVVEENNTTSS     
 

   
01 Aug-20 Oct 09 Community Service  Pop Tab Drive 

 Charity: Ronald McDonald House Charities    
07 Sep 09 ...... *HOLIDAY* Labor Day  
10 Sep 09 ...... Chapter Executive Board Meeting 

 Location:  Bldg 3001, OC-ALC/FM Conf Room  
23 Sep 09 ...... FY09 Soft Closeout  
30 Sep 09 ...... FY09 Closeout    
01 Oct 09 ......       HAPPY NEW YEAR!       

10 Oct 09 ...... Community Service  Charity Marathon 

 Charity: 16th Annual Komen Race for the Cure 
 Location:  Bricktown, Oklahoma City   
12 Oct 09 ...... *HOLIDAY* Columbus Day  
20 Oct 09 ...... Chapter Executive Board Meeting 

 Location:  Bldg 3001, OC-ALC/FM Conf Room  
21 Oct 09 ...... Chapter Luncheon 
 Speaker: Mr Phil Davidson, Mgmt Concepts, Inc. 

 Topic:  “Anti-Deficiency Act” 
 Location:  Bldg 3001, Oklahoma Room    
30 Oct 09 ...... Community Service  Craft Show 

 Charity: Ronald McDonald House Charities 

 Location:  Bldg 3001, Oklahoma Room  
09 & 10 Nov 09  CDFM Mod 1 Audio Training 

 Location:  Bldg 3001, FMA Staff Room  
11 Nov 09 ...... *HOLIDAY* Veterans’ Day  
17 Nov 09 ...... Chapter Luncheon 

 Speaker: Mr John Gioeli, Becker Prof Education 
 Topic:  “CPA Requirements in Oklahoma” 

 Location:  Tinker Club, Ballroom  
20 Nov 09 ...... Chapter Executive Board Meeting 

 Location:  Bldg 3001, OC-ALC/FM Conf Room  
26 Nov 09 ...... *HOLIDAY* Thanksgiving Day  
15 Dec 09 ...... Chapter Christmas Party 

 Special Guest:  Ronald McDonald House Charities 
 Location:  Bldg 5701, Tinker Base Chapel Annex  

15 & 16 Dec 09  CDFM Mod 2 Audio Training 

 Location:  Bldg 3001, FMA Staff Room  
16 Dec 09 ...... Chapter Executive Board Meeting 

 Location:  Bldg 3001, OC-ALC/FM Conf Room  
17 Dec 09 ...... Chapter Luncheon 

 Speaker: Ms Jimmie Nolen, Nolen’s Acctg Service 
 Topic: “Ethics” based on Extraordinary Circumstances 

 Location:  Bldg 3001, Oklahoma Room  
25 Dec 09 ...... *HOLIDAY* Christmas Day  
01 Jan 10 ...... *HOLIDAY* New Year’s Day  
12 & 13 Jan 10  CDFM Mod 3 Audio Training 

 Location:  Bldg 3001, FMA Staff Room 
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                                                NNEEWWSSLLEETTTTEERR  CCOOMMMMIITTTTEEEE  
                            We need roving reporters.   
                          A new committee, specifically 
for the Chapter newsletter, is now being 
formed.  Please contact Tammy Brandt at 
tamara.brandt@tinker.af.mil if you would like to 
be a part of this venture!   Thanks!! 
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CCOONNTTIINNUUIINNGG  RREESSOOLLUUTTIIOONNSS  
  

A continuing resolution (CR) is an 

appropriation act, limited in time only.  

CRs have been used as stop-gap funding 

measures from the late 1880s.  From 1962 

to 2006, 90% of the appropriation bills for 

federal agencies were enacted after the 

start of the fiscal year and thus 

necessitated CRs. 

CRs are temporary appropriations acts.  

GAO refers to CRs as: 
 

“Legislation enacted by Congress 

to provide budget authority for 

Federal agencies and/or specific 

activities to continue in operation 

until the regular appropriations are 

enacted.  CRs are enacted when 

action on appropriations is not 

completed by the beginning of the 

fiscal year.”  (GAO, Principles of 

Federal Appropriations (2
nd

 Ed), 

Volume II, GAO/OGC-92-13, Dec 

1992.) 
 

CRs are usually enacted to cover a 

limited period of time, e.g., a month or a 

calendar quarter.  The time limit stated in 

the resolution is the maximum period of 

time during which funds appropriated by 

the resolution are available for obligation. 

However, this limited period of 

availability does not affect the amount of 

money appropriated by the resolution.  

The rate for operations specified in the 

resolution, whether in terms of an 

appropriation act which has not yet 

become law, a budget estimate, or the 

current rate, is an annual amount.  

Congress can extend availability of 

funds under CR by amending the fixed 

cutoff date stated in the resolution.  

Extensions may even run beyond the 

session of Congress in which they are 

enacted. 

Portions of CR can continue for the 

entire fiscal year if Congress determines 

that some or all of the remaining bills will 

not be enacted individually.  After the 

regular appropriation is enacted, it 

supersedes the CR and governs the period 

of availability and amount.    

  
RRAATTEE  OOFF  OOPPEERRAATTIIOONNSS  

It is common for a CR to require that 

funds be obligated at a rate of operations  

not to exceed the prior year (PY) rate of 

operations.  This begs the question as to 

just what is a rate of operations.  Is it a 

sum of money or a program level?  GAO 

regards the term current rate to mean a 

sum of money rather than a program level. 

The current rate refers to the rate of 

operations carried on within the 

appropriation during the PY.  The current 

rate is therefore equivalent to the “total 

funds” which were available for obligation 

for an activity during the prior fiscal year.  

Funds transferred from the account during 

the fiscal year should not be deducted in 

determining the current rate.  Likewise, 

funds transferred into the account should 

not be added in determining the current 

rate. 

When funds were provided to begin a 

program or project in the middle of a fiscal 

year, you need to annualize the funds to 

determine the current rate.  For example, if 

$500 million was provided for a project/ 

program that was to commence on 1 April 

of the PY, then the current rate of 

operations for the CR in the current year 

(CY) would be $1 billion. 

 
RRAATTEE  NNOOTT  EEXXCCEEEEDDIINNGG  TTHHEE  CCUURRRREENNTT  RRAATTEE  

It is the intent of Congress that an 

agency has no more funds in the CY than 

they had available in the PY.  Therefore, 

under a CR, if there is a balance of 

unobligated funds that can be carried over 

into the current fiscal year, this balance 

must be deducted from the current rate in 

determining the amount of funds 

appropriated under the CR.  For example, 

if $1 billion was provided in an R&D 

appropriation last year, and $750 million 

was obligated as of the end of the prior 

fiscal year, the amount of the 

appropriation under the CR would be $750 

million.  To provide the entire $1 billion 

would be to make $1.25 billion available 

during the CR period. 

 
CCRRAA  SSPPEENNDDIINNGG  PPAATTTTEERRNN  

An agency may determine its pattern of 

obligations under a CR so long as it 

operates under a plan that will keep it 

within the rate for operations limit set by 

the resolution.  If an agency usually 

obligates most of its annual budget in the  

first month or first quarter of the fiscal 

year, it may continue that pattern under the 

resolution.  If an agency usually obligates 

funds uniformly over the entire year, it 

will be limited to that pattern under the 

resolution, unless it presents convincing 

reasons why its pattern must be changed in 

the current fiscal year.  

  
RRAATTEE  OOFF  OOPPEERRAATTIIOONNSS  EEXXCCEEEEDDSS  FFIINNAALL  AAPPPPRROOPPRRIIAATTIIOONN  

If you obligate at the current rate, and 

Congress finally appropriates at a lesser 

rate, have you committed an ADA 

violation?  The answer to that question is 

no. 

In a GAO decision 62 Comp Gen 9 

(1982), the CG held that funds legally 

obligated under the authority of a CR 

remain available to pay the obligations 

incurred which exceeded the final 

appropriation.  The decision stated, “…to 

the extent the annual appropriation act 

does not provide sufficient funding for the 

appropriation account to cover obligations 

validly incurred under the CR, the 

obligations in excess of the amount 

provided by the annual act should be 

charged to and paid from the appropriation 

account established under the authority of 

the CR….  Thus, the funds made available 

by the resolution must remain available to 

pay the obligations.” 

GAO has advised that agencies should 

make their best efforts to remain within 

the amount of the final appropriation.  To 

the extent the agency is unable to do so, 

the appropriation made available by the 

CR remains available to liquidate the 

excess obligations. 
 

PPRROOJJEECCTTSS,,  AACCTTIIVVIITTIIEESS,,  AANNDD  NNEEWW  SSTTAARRTTSS  

Most CRs contain provisions restricting 

“new starts.”  The term refers to the 

restriction on the use of funds for “any 

project or activity for which 

appropriations, funds, or other authority 

were not available” during the preceding 

fiscal year.  Therefore, if an agency had 

funds to carry out a program or project in 

the preceding fiscal year, that program is 

not a new start even if the agency failed to 

actually begin the program or project in 

the previous fiscal year.  

 

From the Enhanced Defense Financial Management Training Course, Module 3 (Accounting and Finance), October 2008, pages 3.1.42 thru 3.1.45.  
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ACROSS DOWN 
 2 The period during which budgetary resources may incur new obligations 

is different from the period during which the budgetary resources may be 
used to incur expenditures; annual, multi-year, and no-year authority. 

 3 An administrative reservation of funds in anticipation of a future obligation.  
 5 Amounts earned and collected for property sold or services furnished to 

the public or to another U.S. Government agency. 
 6 An Act that prohibits an obligation in excess of the appropriated amount 

or amount permitted by agency regulations. 
 8 Includes documentation, recording or transactions and events, execution 

of transactions and events, separation of duties, supervision, access to 
and accountability for resources, and audit resolution. 

 10 Collections creditable to Treasury Department miscellaneous accounts 
or funds as authorized by legislation. 

 12 The cancellation of budgetary resources provided by discretionary 
appropriations or direct spending legislation, following procedures 
prescribed in law. 

 13 Outflow or other using up of assets or incurrences of liabilities during a 
period from providing goods, rendering services, or carrying out other 
activities related to an entity’s programs and missions. 

 15 A component of a reporting entity that obtains goods for direct use in its 
normal operations. 

 17 The amount by which receipts exceed outlays in a fiscal year. 

 1 A document establishing a legal relationship between two legally-competent 
parties, defining the rights and responsibilities of each party. 

 4 The transfer of funds between program elements or line items within an 
appropriation for purposes other than those contemplated at the time of 
appropriation. 

 7 A recoupment of a payment made in error. 
 9 The Rule that states that a fiscal year appropriation may be obligated only to 

meet a legitimate need arising in the fiscal year(s) for which the appropriation 
was made.    

11 Any cost specifically identified with a particular final cost objective. 
14 This type of program is a directed, funded effort that is designed to provide a 

new, improved, or continuing weapons system or automated information 
system capability in response to a validated operational need. 

16 An existing condition, situation, or set of circumstances involving uncertainty 
as to possible gain or loss to an entity that will ultimately be resolved when 
one or more future events occur or fail to occur. 

18 Funds held for use in carrying out specific purposes and programs in 
accordance with an agreement or statute. 

19 The monetary value of resources used or sacrificed or liabilities incurred to 
achieve an objective, such as to acquire or produce a good or to perform an 
activity or service. 

20 A legal limit on the budget authority and outlays for each fiscal year provided 
by discretionary appropriations. 

 
AAnnsswweerrss  ttoo  oonn  PPaaggee  99..  

21  “___”-Years are beyond the year being worked in the upcoming budget. 
22 Obligations and expenditures may not exceed the total established in law. 

 
  

RREECCRRUUIITT  AA  NNEEWW  AASSMMCC  MMEEMMBBEERR  TTOODDAAYY!!    CCoonnttaacctt  PPaamm  MMyyeerrss,,  11
sstt
  VViiccee  PPrreessiiddeenntt  ooff  MMeemmbbeerrsshhiipp,,  aatt  ppaammeellaa..mmyyeerrss@@ttiinnkkeerr..aaff..mmiill..  
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National ASMC News  What is money made of?  

SSeepptteemmbbeerr  &&  OOccttoobbeerr  22000099  
  

ASMC AWARDS ONLINE 

We're excited to announce the Chapter Award section of the awards submission 

website is complete.  As you may recall, in the last National News we announced all 

awards submissions will be done via this website including individual and team 

achievement awards, essay competition, scholarships, and, yes, even the extensive 

submission requirement for our annual Chapter Competition.  To register your chapter 

and begin uploading your documentation and managing your Chapter Competition 

via the website, click on the ASMC Award Online Chapter Competition page.  Each 

chapter must designate one officer to register for the chapter.  That login information 

should be shared by anyone in the chapter inputting information in the form.  Training 

on the Chapter Competition piece of the website was held on 8 October.  If your 

chapter missed this training, it is available for viewing until 26 October.  Please contact 

Jennifer Sizemore for the link to the recorded session.  
 

MODULE 4 CLASSES - Register Today! 

Acquisition Business Management (Module 4) FY10 Course Schedule ·  Norfolk, VA, 

December 15 - 16, 2009 ·  Ft. Meade, MD, January 14 - 15, 2010 ·  Washington, DC, 

March 18 - 19, 2010 ·  San Antonio, TX, March 30 - 31, 2010 ·  Denver, CO, April 13 - 14, 

2010 ·  Dayton, OH, May 18 - 19, 2010 ·  Huntsville, AL, June 22 - 23, 2010 ·  Washington, 

DC, July 13 - 14, 2010.  You may now reserve a seat by registering for the class in the 

location of your choice with the online registration form.  The registration fee is $375 per 

student for the two-day course.  Registrations must be received 30 days prior to course 

start dates.  To request and submit registration information: cdfmamod4@aol.com. 
 

MONTHLY CDFM AUDIO TRAINING 
Beginning November 2009, ASMC will hold monthly intensive review sessions of select 

modules of the CDFM exam over audio lines.  For each module, there will be two four-

hour sessions on consecutive days; each session starts at 12 noon Eastern.  There is a 

charge of $99 per line for each module; as many can participate on one line as you 

wish.   Go to the ASMC home page for more information including information about 

the textbook to be used and how to register online.  Registration is now open for 

November 2009 Module 1 training only.  NOTE:  This "top off" intensive training is 

designed for those that have already taken the Enhanced Defense Financial 

Management Training Course (EDFMTC). 
 
The full schedule, including EDFMTC instructors, is as follows: 

 Module 1:  November 9 - 10, 2009, Pamela Robinson, CDFM-A  

 Module 2:  December 15 - 16, 2009, Doug Atkins, CDFM  

 Module 3:  January 12 - 13, 2010, William Arnold, CDFM-A  

 Module 1:  February 9 - 10, 2010, Jayne Reinhart, CDFM  

 Module 3:  March 24 - 25, 2010, Milo Hall, CDFM-A  
   

EDFMTC OPEN ENROLLMENT COURSES 
There are several open enrollment sessions, delivered by Management Concepts, Intl., 

with openings available for students interested in receiving top notch training in DoD 

FM.   Please check out the ASMC website under the Certification tab and click on the 

Training link for a complete listing of sessions. 
 

CHAPTER MEMBERSHIP ROSTERS 

The chapter roster is available online to the chapter president (and only to the chapter 

president).  Directions on how to access that roster may be found under Chapter 

Management.  It is ASMC policy to not share its membership file with any entity or 

person outside of ASMC leadership.  

 Please respect this policy at the local level.  

 Do not provide the membership roster to any source outside your chapter leadership 

and always protect the file by locking it with a password.  

 Do not post your member listing on any website or in any public forum. 
 

PDI ONLINE 
Please announce at your next meeting that chapter members can earn free CPE 

credits by listening to or watching taped workshops and Service Day sessions from PDI 

2008 and PDI 2009.  You can now access selected sessions online at the PDI extended 

learning page, along with the briefing charts received to date. 

   
Coins are usually made of copper 

and another element, such as zinc 

or nickel. Currency paper is 

composed of 25% linen and 75% 

cotton.  Red and blue synthetic 

fibers of various lengths are 

distributed evenly throughout the 

paper.  Before World War I these 

fibers were made of silk. 
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Our 1st Annual 
Chapter Christmas 
Party is tentatively 
planned for Tuesday,  
15 Dec 09, from 1501 to 
1700 hours, in the 
Tinker Base Chapel 
Annex.  This event will 
allow our members an 
opportunity to 
network with fellow 
FMers, as well as, 
participate in party 
games and indulge in 
complimentary hors 
d’oeuvre and punch.   

We are inviting 
members to bring and 
sign up new members 
at the party to earn free 
luncheon tickets—
more information is to 
come.  If you have any 
questions, please feel 
free to contact Tammy 
Brandt at 336-2326 or 
Loretta McCoy at   
884-1598.  

mailto:cdfmamod4@aol.com
http://www.factmonster.com/cgi-bin/id/A0774847
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With meetings and the general chaos of a normal work day, your email Inbox can quickly get cluttered.  An 
unorganized mailbox can make it difficult to find the email you need and know where to get started.  This 
messy situation can be remedied.  Microsoft Office Outlook offers great tools that help you organize your 
messages in meaningful, easy-to-control ways.  Here are some tools in Outlook that you can use to manage 
your email.  You can use one of these tools—or a combination of tools—to help shrink your Inbox and make it 
easier to find the information you need. 

 
 

1. GROUP SIMILAR MESSAGES IN FOLDERS    
By creating new mail folders, you can group messages related to each other.  For example, you can group messages 
by topic, project, contact, or other categories that make sense to you.  You can even create a folder for all the 

messages from your manager or that include tasks that you have to complete. 
 

 ADD A FOLDER 
1. On the File menu, point to Folder, 

and then click New.  
2. Type the name of the folder you 

want to create in the Name box.  

3. For Select where to place the 
folder, click the folder where you 

want to create your new folder.  

 
RENAME A FOLDER 
1. In the Navigation Pane, right-

click the folder you want to 
rename.  

2. Click Rename "folder name."  

3. Type the new folder name, and 
then press Enter.  

 
REMOVE A FOLDER 
1. In the Navigation Pane, click the 

folder you want to delete.  
2. On the Edit menu, click 

Delete.  

3. Click Yes to confirm the 
deletion of the folder and all of 

its contents. 
 

2. CREATE SEARCH FOLDERS TO FIND MESSAGES FAST 
Search Folders are a quick and convenient way to look at predefined collections of email messages.  They don't 
actually store any messages themselves, but instead are virtual folders that offer a view of all the messages stored in 

your mailbox depending on the attributes you've defined.  Outlook provides default Search folders—such as Unread 
Mail—but you can also create your own.  For instance, you can use Search Folders to help you find all the information 

related to a particular project, an important client, or an upcoming conference.  
 

  In Mail, on the File menu, point to New, and then click Search Folder.  

 Opt whether you want to use a predefined Search Folder or create your own, and then follow the instructions on the 
screen. 

 
3. LAY ON THE COLOR 

One quick easy way to distinguish between email messages is to color code them.  By using color, you can quickly 
identify messages from certain contacts by customizing your Inbox to automatically color messages.  For example, it's 

an easy way to identify important messages from a key customer, your manager, or an important contact.  Even 
better, it's quick and easy. 

 COLOR MESSAGES SENT ONLY TO YOU 

1. On the Tools menu, click Organize. 
 

   
2. In the Ways to Organize Inbox dialog box, click Using Colors.  

3. After Show messages sent only to me in, click the color that you 
want in the list.  

4. Click Turn on.  

5. Close the Ways to Organize Inbox dialog box.  

 

  NOTES   

 To further customize how these 
messages appear, such as their font 

style and size, click Using Colors, 

and then click Automatic 
Formatting in the Ways to 

Organize Inbox dialog box.   
 To turn off the color setting, click 

Turn off.   
 To change the color, click Turn off, 

click the color that you want in the 

list, and then click Turn on.  
 

“Seven Ways to Organize Your Email” Continued on Page 9.             

javascript:AppendPopup(this,'olnavigationpane_1_1')
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4. SORT MESSAGES QUICKLY 

You can find messages in mailbox folders more quickly by changing how they're sorted in your email folders.  For 

example, you can arrange your email by date, sender, file size, or even by conversation, which pulls up all messages 
by the subject line.  

 APPLY OR CHANGE AN ARRANGEMENT 
The default arrangement used to view messages is the Date 
arrangement. You can switch to any of the other predefined 

arrangements by following the steps below. 
1. On the View menu, click Arrange By.  

2. Click the arrangement you want.   
To customize the arrangement you just applied, on the 

View menu, click Arrange By, and then click Custom, 
and then select the options you want.  

 
 
 TIP   To quickly change from one standard arrangement 

to another: 

 In single-line layout, right-click a column heading, 
click Arrange By on the shortcut menu, and then 

click the arrangement you want.  
 In multi-line layout, right-click the Arranged By: 

Arrangement name column, and then click the 

arrangement you want.    
5. REDUCE UNWANTED EMAIL WITH JUNK FILTERS 

Keep distracting and unwanted messages out of your inbox by using Outlook junk email filters.  These filters send 

email flagged as junk to a separate mail folder under your Mailbox.  You can review the contents of this folder to 
ensure no legitimate messages have been sent there, and if so, you can adjust the filter to avoid flagging such 

messages in the future. 

 
 

HOW THE JUNK EMAIL FILTER WORKS 
The Junk Email Filter evaluates each incoming message to 

assess whether it may be spam, based on several factors. 
These can include the time when the message was sent 

and the content of the message.  By default, the Junk 

Email Filter is turned on and the protection level is set to 
Low.  This level catches only the most obvious spam. You 

can make the filter more aggressive by changing the level 
of protection.  Also, the Junk Email Filter can be updated 

periodically to protect against the latest techniques that 

spammers use to spam your Inbox. 
 

  

NOTE   The Outlook Junk Email Filter does not stop 

junk email from being delivered, but rather diverts 

suspected spam to your Junk Email folder instead of 

your inbox.  Some third-party solutions are available 
which can be more aggressive on this front. 
 

 TIP   You can control many of your Junk Email Filter 

settings with the Junk Email Options dialog box. 

From your Inbox, in the Actions menu, point to Junk 
Email and then click Junk Email Options. 

“Seven Ways to Organize Your Email” Continued on Page 10. 
 

Invite someone to become an AASSMMCC  mmeemmbbeerr today. 
Find more information at www.asmconline.org. 
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6. FLAG FOR FOLLOW UP 

You can flag email messages, tasks, and more with colored Quick Flags to help classify them or mark them for action. 

Flags can remind you to follow up on an issue, indicate a request for someone else, or set a reminder for a message 
or contact.  Best yet, they make organizing your mail folders a breeze, because you know exactly what to do—and 

when to do it. 

 PRIORITIZE WITH FLAGS AND 
USE THE TO-DO BAR 
1. Right-click in the Flag Status 

column  next to the message that 
you want to flag, and select a flag 
type (for example, click Today to 
give it a Today follow-up flag).  

2. Look at your To-Do Bar and notice 
that the message now shows up 
there. (If you have other tasks in 
the To-Do Bar, you may need to 
scroll to see it.)  
 

  

Here are some things to remember about flagged messages and 
the To-Do Bar: 
 In the To-Do Bar, you can change the subject of the flagged 

message without affecting the subject that appears in the 
Inbox.  To do this, click to select the text of the item in the To-
Do Bar and type the new subject.  

 When you've completed an item, use the Mark Complete 
command.  

 Flagged messages show up in the To-Do Bar, on your Calendar, 
and in Tasks.  (And, remember that deleting a flagged message 
will delete it from your Inbox, from the To-Do Bar, and from the 
Calendar).  

 You can drag items to the Date Navigator in the To-Do Bar to 
quickly set up an appointment for the day that you drag to.  

 Press ALT+F2 to minimize, show, or hide the To-Do Bar.  
 Use the Minimize the To-Do Bar button to keep it visible, but 

smaller.  
 

7. ROUTE MAIL EFFICIENTLY USING MAILBOX RULES 
By creating rules for Outlook, you can automatically perform actions on both incoming and outgoing messages based 
on the criteria you establish.  For instance, you can automatically forward to your manager all messages sent by a 

certain person as soon as they arrive, assign the category Sales to all messages you send that have the word "sales" 
in the Subject line, and much, much more.  Routing mail efficiently not only organizes your mail for you—but also 

frees up your time from performing routing tasks.  

 CREATE A RULE FROM SCRATCH 
To create a rule by choosing your own conditions, 

actions, and exceptions, do the following: 
 
1. In the Navigation Pane, click Mail.  

2. On the Tools menu, click Rules and Alerts.  

3. If you have more than one email account, in the 
Apply changes to this folder list, select the 

Inbox that you want.  
4. Click New Rule.  

5. Under Start from a blank rule, select either 

Check messages when they arrive or Check 
messages after sending, and then click Next.  

6. Under Step 1:  Select condition(s), select the 
conditions that you want the messages to meet for 

the rule to apply.  
7. Under Step 2:  Edit the rule description, click an 

underlined value if you have not done so already, 

and then click Next.  

 
8. Under Step 1:  Select action(s), select the action 

that you want the rule to take when the specified 

conditions are met.  
9. Under Step 2:  Edit the rule description, click an 

underlined value if you have not done so already, and 

then click Next.  
10. Under Step 1:  Select exception(s), select any 

exceptions to the rule, and then click Next.  
11. To finish creating the rule, enter a name for the rule, 

and then select any other options that you want.  
 

 If you want to run this rule on messages that already 
are in one of your folders, select the Run this rule 

now on messages already in "folder" check box.  
 

 To apply this rule to all your email accounts and the 

Inbox associated with each account, select the Create 
this rule on all accounts check box.  
 

Click Finish. 
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